
Vallen JPegger
Overview

Introduction

Vallen JPegger is a handy image viewer program. It allows one to quickly browse through directories with 
many images simply by cursor keys <Up> and <Down> (see also: Keyboard Shortcuts).

Vallen JPegger reads most common Windows bitmap file formats (A complete list of supported image 
formats can be found at the end of this chapter).

Additionally it includes an automatic slide show mode where it shows one picture after the other in an 
user-specified time interval.

You can copy Vallen JPegger for your personal needs. The program is provided as is. There is no technical 
support provided for this program. There is no liability or warranty for any damages that might arise from
use of Vallen JPegger.

Note: Your comments are highly appreciated especially concerning bugs. But please also comment if you 
like or Vallen JPegger.

Features:

· File Viewer supports 40 different image formats such as BMP, JPEG, PCX, GIF, TIFF, EPS, PNG, TGA, 
VST, PSP-files and a few more minor and sub-formats.



See below for a complete list of supported image formats.

· New: EXIF codes supported

· New: MP3 Explorer included

· New: MP3 Tag Editor (ID3v1 / ID3v2)

· New: Twain Scanner/Digital camera interface included

· New: Print postcards (From 2 up t o144 images on one single page in best quality!)

· Multi language interface

· CD-Starter tool VStarter added.

· Improved: Sound interface added! Make your own audio comments for your images.

· Command line interface added.

· Tools - Find duplicate files 

· Directory tree added.

· Quick access file list of all images in the currently selected directory (see also: File Order)

· Thumbnails! View and print support.

· Full screen display modes <F11> and <Ctrl+F11> or simply <Return> (see also: Keyboard 
Shortcuts)

· User defined file order, by name, size, time or random (see also: File Order)

· Keyboard controlled for fast navigation (see also: Keyboard Shortcuts)

· Slide show mode with user-defined time interval (see also: Slide show Mode)

· Dynamic zoom function (from 25% to 1000% and fit to window, see also Menu View)

· Mouse panning when zoomed (see also: Mouse Panning)

· Clipboard Copy and Paste (see also Menu Edit)

· Built-in file Copy, Move, Delete and Rename

· No installation required. Simply copy files into target directory and run JPegger.exe

· See Version history for latest changes.

Why another image viewer?

There are many professional bitmap viewers available. Most of these programs not only allow to open and
view the bitmap but also offer many tools for editing the image.

The advantage of Vallen JPegger is that it is small and highly versatile. Open one file out of a directory full
of bitmaps and navigate to the next or previous with the cursor keys. No installation required.



Getting Started

Please start with chapter Main Menu.

Supported Image formats (with thanks to Mike Lischke):

· TIFF images (*.tif; *.tiff), extended base line implementation
1..16 bits per sample 
indexed, grayscale, RGB(A), CMYK, L*a*b* 
uncompressed, packed bits, CCITT T.4, Thunderscan, Deflate, new style JPEG

· GFI fax images (*.fax), 

· SGI images (*.bw, *.rgb, *.rgba, *.sgi) 
1..16 bits per sample 
indexed, grayscale, RGB(A) 
uncompressed, RLE 

· Autodesk images files (*.cel; *.pic) old style only 
8 bits per sample, indexed and uncompressed 

· Truevision images (*.tga; *.vst; *.icb; *.vda; *.win),
5 and 8 bits per sample 
grayscale, indexed, 15 bits RGB (555), 24 bits RGB(A)(888) 
uncompressed, RLE 

· ZSoft Paintbrush images (*.pcx, *.pcc; *.scr) 
1..8 bits per sample 
grayscale, indexed, RGB 



uncompressed, RLE 

· Kodak Photo-CD images (*.pcd) 
8 bits per sample in YCbCr in any resolution (192 x 128 up to 6144 x 4096) 

· Portable pixel/gray map images (*.ppm, *.pgm, *.pbm) 
1 and 8 bits per sample 
grayscale, indexed, RGB uncompressed 

· Dr. Halo images (*.cut, *.pal) 
8 bits per sample indexed, RLE compressed 

· CompuServe images (*.gif) 
1, 4, 8 bits per sample indexed, compressed 

· SGI Alias/Wavefront images (*.rla, *.rpf) 
8 bits per sample RGB(A), RLE compressed 

· Standard Windows bitmap images (*.bmp, *.rle, *.dib) 

· Photoshop images (*.psd, *.pdd) 
1, 8, 16 bits per sample 
indexed, RGB, CMYK, CIE L*a*b* 
uncompressed and packed bits 

· Paintshop Pro images (*.psp) 
1, 4, 8 bits per sample 
indexed, grayscale, RGB 
uncompressed, RLE and LZ77 
single-layered files only! 

· Portable network graphic images (*.png) 
1, 2, 4, 8, 16 bits per sample 
indexed, grayscale alpha, RGB(A), LZ77 compressed 

Disclaimer:

This program in its current version is freeware and may be freely distributed in its original unmodified 
form. This program is supplied as is without any warranties whether expressed or implied. There is no 
liability or warranty for any damages that might arise from use of this program.

Vallen-Systeme GmbH assumes no responsibility for any loss of money, time or productivity, or damages 
in any way to any person(s) or computer hardware or software as a result of using this program. Even if 
Vallen-Systeme GmbH had knowledge or had been notified of the possibilities of such events the user of 
this program must assume the entire risk of using the program. 

The program is provided as is. There is no technical support provided. The current version of Vallen 
JPegger is non-commercial. This program cannot be sold. No registration required.

All trademarks or registered trademarks are properties of their respective owners.
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Main Menu
Description of commands found in menus

The main menu provides access to many of the functions of Vallen JPegger. The most often used functions
are also available via a tool bar. Move the cursor over the tool bar to get a tool tip for each button. For 
each button there is a menu item which is described in detail.

Menu File

Standard file operation commands. See chapter Menu File for details.

Menu Edit

General edit functions. See chapter Menu Edit for details.

Menu View

General view functions. See chapter Menu View for details.

Menu Image

Provides image editing functions like rotate and flip (mirror). See chapter Menu Image for details.

Menu Tools

Additional tools. See chapter Menu Tools for details.

Menu Help

Calls the online help system.
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Menu File

The File menu offers well known Windows functionality for opening and closing projects, as well as 
printing. This menu can be found by File out of the main menu.

 Open (shortcut <Ctrl+O>)

Opens a new image. All images in the same directory of the file opened are shown in the file list at the 
left hand side of the window (see also chapter File Order).
 Browse (shortcut <Ctrl+B>)

Opens a dialog that allows one to browse for another folder. Check "Recurse subfolders" to include images
out of all subfolders.

 Close (shortcut <Alt+F4)

Closes the currently open image and clears the file list.

Save As…

Allows to save current image as BMP or JPG file.

Twain Import -> Select Source

Opens the Twain source selection dialog to specify a scanner or digital camera

Twain Import -> Acquire

Opens the Twain interface to acquire a still image.
 Print (shortcut <Ctrl+P>)



Opens the Print Preview dialog for printing the current image.
 Print thumbnails

Opens the Print Preview dialog for printing thumbnails. The print size for the thumbnails is defined in 
Preferences. Sound files thumbnails are not printed.

 Print postcards

Opens the Card Layout Dialog for printing all types of card sizes. Sound files thumbnails are not 
printed.

Update file List

Re-synchronizes the file list shown with the folder contents.

Update thumbnails

The thumbnails are rebuilt according to the current thumbnail size set in the Preferences dialog.

Copy file to (shortcut <Ctrl+C>)

Opens a dialog to browse a target folder to copy the currently opened file to.

Move file to (shortcut <Ctrl+X>)

Opens a dialog to browse a target folder to move the currently opened file to.

Rename file (shoprtcut <F2>)

Asks for a new file name to rename the file.

Delete file (short cut <Del>)

Moves the currently opened file to the recycle bin.

Preferences (shortcut <Ctrl+R>)

Opens the Preferences dialog box that to allows to modify file format associations and certain start-up 
defaults.

Most recently used file list (MRU-list)

The MRU-list is a history list that allows one to quickly access the most recently used files.

Exit

Quits Vallen JPegger.
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Menu Edit

The Edit menu provides functions that affects the currently loaded image. This menu can be found by 
Edit out of the main menu.

Clipboard commands:
 Copy

Copies the currently shown image to the clipboard.
 Paste

Pastes an image from the clipboard into JPegger. This will also clear the file list as the current directory is 
no longer valid.

Directory sort commands:

Sort by Name, Location, Size, Time

Sorts the current file list accordingly (see also chapter File Order, these functions are also available 
there).

Random Order

Randomly orders the file list. Each click on this item reorders the list. Useful for a slide show (see below).

Screen capture commands:
 Screen capture

Opens the Screen Capture Dialog

Desktop wallpaper commands

Set centered, tiled, stretched

Sets the currently shown image as desktop wallpaper. Display the image either centered, tiled or 
stretched. Stretched wallpapers require Windows 98/2000 or higher and might not work on Windows 95 
based machines.

Clear desktop wallpaper

Removes the current desktop wallpaper and shows the default background.



Slide show commands
 Slide show (shortcut <F10>)

Starts and stops the slide show mode. When started all images in the file list are shown sequentially in 
the current order. When the end of the list has reached the slide show restarts on top of the list 
automatically. See also chapter Slide show Mode. See Preferences for slide show time interval.
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JPegger: Screen Capture Setup
Screenshots quick and easy
The Screen Capture Setup allows one to quickly make Screenshots of your desktop or any window. This
dialog can be found by Screen Capture out of the Edit menu.

Capture:

Define here, if you want the capture a single window only or the desktop as a whole.

Activate capture using:

You can either activate the screen capture by a Delay Timer or by a keyboard hotkey. The Delay Timer 
specifies the time in seconds after which the screen is captured automatically.

With the keyboard hotkey the screen is captured with the press of this hotkey.

Note: When you start the screen capture JPegger hides itself to allow a screen capture without 
interference with JPegger. Please press the hotkey for wait for the Delay Timer and JPegger will 
pop up again.
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Menu View

The View menu provides functions that affects scale the loaded image is shown. This menu can be found 
by View out of the main menu.

Toolbar

Shows the toolbar if checked.

Tool tips

If checked then tool tips (hints) are shown in a yellow box for all controls when the mouse is moved over 
the same control for more than half a second. When you got used to the toolbar you might find it more 
comfortable to switch of the tool tips.

Scale to fit ( )

Scales the currently loaded image that it exactly fits completely into the window.

Scale    50% ( ), 100% (
),    200% (
)

Scales the currently loaded image accordingly based on the original image size. There are more scale size
available with the mouse (see also chapter Mouse Panning and Zoom).

Flip thumbnails ( )

This function flips the thumbnails from left to the right hand side. There is a separate chapter on this 
issue.

Full screen (shortcut <F11>)

Shows Vallen JPegger full screen without window border and taskbar. Press <F11> again or <Esc> to 
reset.

Full screen image (shortcut <Ctrl+F11>)

Shows the image full screen. Press <Ctrl+F11> again or <Esc> to reset.
 Minimize (shortcut <Ins>)

Minimizes JPegger quickly.
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Menu Image

The image menu provides some image editing functions.

Flip horizontally/vertically

Provides a simple mirror function.    Lossless JPG transformations used if possible. See note at end of 
page.

Rotate Left/Right

Image rotate function. Lossless JPG transformations used if possible. See note at end of page.

Resample Image

Opens the Resample dialog to resample (resize) the image

Show EXIF Information

Shows the EXIF information stored by digital camera or scanner during image sampling.

About lossless JPG transformations
Vallen JPegger uses lossless JPG transformations specified by the Independent JPEG Group since version 
4.14 for horizontal and vertical flipping (mirroring) and all rotation functions.

If the file the transformations is applied on is detected to be a valid JPG then the transformation is 
applied directly on the original JPG file without decompressing it. As a result there is no loss in image 
resolution as the file is not decompressed, rotated and re-compressed afterwards.

This transformations can be repeated as often as you like without any loss of image quality. Therfore the 
transformed image is saved to the original filename automatically after transformation.

The original file is copied to the recycle bin and as a result is not lost.

Note: The only trade-off that can happen using the lossless transformation functions is that the image 
size might be decrease by a few pixels in case the source buffer is not padded out to a full iMCU 
boundary. However the original image is still available in the recycle bin.
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Resample Image
Resizing an image

This dialog box is available via Resample Image out of Image menu.

First specify the image dimension units. Then specify the new dimensions or give a scale factor for either 
horizontal or vertical size. 

The Resolution is the scale factor used for converting image size in pixels to any units. The Resolution is 
saved only in "BMP" format.

Check Anti-Alias to use the slow but high-quality Lanzcos algorithm for resampling the image. If not 
checked a faster Triangle algorithm is used.

Check Aspect-ratio if you want to keep the given with to height ratio of the image when resizing.
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Menu Tools

The Tools menu provides additional helpful tool functions. This menu can be found by Tool out of the 
main menu. This menu will be subject to change with future versions.

Find duplicate images

Browses the current open folder for duplicate identical images. If you are working with many images then
it easily happens that you have the same image more than once as a result of copy or backup operations.
To filter out those images easily use this function.

There is a popup window after operation showing a results report. Each line represents one identical file 
pair shown in the left and right list box. To delete images select either from the right or the left listbox. 
Use <Shift> and <Ctrl> keys for multi select.
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Preferences
Start up Options

This dialog box is available via Preferences out of File menu.

Start-up options :

If Load last open image on start is checked    then Vallen JPegger automatically loads the image that 
was shown the last time when the program was closed.

Key stroke options:

Check Quit Vallen JPegger with <Esc> if you want JPegger to quit after pressing the <Esc> key. 
Normally JPegger is terminated via Exit out of the File menu or <Alt+F4> only. 

Full screen options:

If Hide cursor in full screen is checked then the cursor is hidden when an image is shown in full screen 
image mode (see menu View).

With Show image information in full screen checked some file information like file name and size and 
file index is shown on the left hand side in full screen mode.

Hint: The former Start in full screen mode option has been replaced by command line option /fs. The 
default image scale has been superseded by command line option /sc:<scale>.

Print options:



These options allow to add an image information line when printing. Check all items you whant to see 
printed in a line below the image.
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Preferences
Slide show settings

This dialog box is available via Preferences out of File menu.

 

Slide show time interval

Setup the time interval for slide show mode in seconds. Vallen JPegger internally uses read-ahead to keep
the interval as exact as possible as long as the time required for loading and decompressing the image is 
shorter than the specified time interval.

Valid range is from 100 milliseconds up to 1 hour.

Slide show always in full screen

If checked then full screen mode is enabled automatically when slide show is started. Full screen is 
disabled when slide show is terminated.

Hint: You can also use a command line option if you want to start Vallen JPegger in Slide show mode.

Disable screen/monitor saver in full screen

If checked it disables the screen saver and monitor save mode when running in full screen slide show 
mode and JPegger being the top most application.
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Preferences
Setup
This dialog box is available via Preferences out of File menu.

Click Create desktop icon to add or update a desktop icon link to the current location of    the 
executable Vallen JPegger file. A dialog pops up that allows you set some command line options.

See chapter command line options for detailed description of individual switches. The switches checked
in this dialog will be added to the desktop icon and therefore are your future default options.

To remove the desktop icon, click Remove desktop icon.

Language



JPegger has Multi language support. Use this combo box to select you preferred language.

Currently English, German, Italian, Portuguese, Swedish, Dutch, French ad Spanish is supported.

Special thanks to Marco D'Amato for his Italian translation.

Special thanks to Nuno Justo for his Portuguese translation.

Special thanks to Ulf Swedjemark for his Swedish translation.

Special thanks to Frank van de Laar for his Dutch translation.

Special thanks to Vincent Malien and Denis Mentha for their French translation.

Special thanks to Antonio Mengs for his Spanish translation.
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Preferences
Thumbnails
This dialog box is available via Preferences out of File menu.

Specify the size of the thumbnails to be shown. Please select the thumbnail size carefully. The bigger the 
thumbnails are, the more memory is required. Sizes bigger than 200 pixels slow down the handling and 
might produce problems on Windows 9x based machines.
Also depending on the number of thumbnails shown and installed memory.

Thumbnails are printed via "Print thumbnails" out of menu file. When printing the base image size of the 
thumbnails is identical to the thumbnail size in pixels specified here.

Additionally a thumbnail size in mm can be specified. The thumbnail image is scaled to fit inside this size. 
The size specified here is exactly the size the thumbnail image is printed. Around the image a frame is 
drawn in a distance of 1mm to each edge. But you can specify the offset which is the distance between 
the thumbnail images.

Use the thumbnail size in mm, the offset in mm, and the page settings to define how many thumbnails 
you want to print on one page.

Thumbnails saving options

Thumbnails are saved automatically by default into the same folder in a file jpeggeri.dat where its 
images are. This is for faster display if the thumbnails have been created once and you re-visit a folder. 
You can disable this option by unchecking Always save thumbnails. The option Hide jpeggeri.dat 
files controls if the file attribute should be set to hidden automatically.

JPegger_PreferencesThumbNails





Preferences
File associations

This dialog box is available via Preferences out of File menu.

Use this dialog box to select which files your computer opens automatically using Vallen JPegger.

Each line in the list represents one specific file extension with the according file format description. Click 
on a row to check/uncheck it.

Already registered file extensions are shown checked when the dialog box is opened. Uncheck those to 
remove existing associations.

Click the "Register..." button when finished your selection. Then all checked extensions will be associated 
to Vallen JPegger. All associations that have been previously performed and are not checked will be 
removed.

Note: No modifications are performed as long as the "Register..." button has not been pressed. 
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Keyboard Shortcuts
Navigating through bitmaps

Simply open a file using File/Open.

The following keyboard commands are available to navigate through bitmaps:

<Home> Show the first image in the directory

<End> Show the last image in the directory

<Up> Show the previous image

<Down> Show the next image

<Page-Up> Next image in full screen

<Page-Down> Previous image in full screen

<numeric +> Zoom in (same as left mouse click on image); alternatively use mouse wheel

<numeric -> Zoom out (same as right mouse click on image); alternatively use mouse wheel

<numeric x> (Multiply key, numeric keypad), Scale image by 100% relative to the original

When the image is shown in full screen mode, some of the keys do have a different meaning:

<Up> Vertical panning up

<Down> Vertical panning down

<Left> Horizontal panning left

<Right> Horizontal panning right

<Page-Up> Show the previous image

<Backspace> Same as above.

<Page-Down> Show the next image. Same as mouse click into image.

These functions are available over a context menu also.

The following commands are also available via "View" menu or tool bar:

<F5> ( ) Auto scale image to fit into the window
<F6> ( ) Scale image by 50% relative to the original
<F7> ( ) Scale image by 100% relative to the original
<F8> ( ) Scale image by 200% relative to the original

Other scales are possible via mouse click on the image. A left mouse click zooms into the picture, up to 
1000%, a right mouse click zooms out down to 25%. You also can use the <+> and <-> keys to zoom in
and out.

<Ctrl+C> ( ) Copies the currently shown image to the clipboard.
<Ctrl+V> ( ) Pastes an image from the clipboard into JPegger. This will also clear the file list as the 
current directory is no longer valid.
<Ctrl+R> Opens Preferences dialog box.
<Ins> ( ) Minimizes JPegger
<F11> Shows Vallen JPegger full screen without window border and taskbar. To reset press either <Blank> 
or <Return> or <Escape> (Escape might be used to quit Vallen JPegger. See Key stroke options in 
Preferences).

<Ctrl+F11> Shows the image full screen. To reset see description above for <F11>.

<Return> Same as <Ctrl+F11>, also double click on thumbnail or file list entry.

<Ctrl+F4> ( ) Closes currently open image.
<Ctrl+P> ( ) Opens the Print Preview dialog for printing.
< Del> Moves currently open image to the recycle bin (file delete)



<F2> Renames the image
<Ctrl+Alt+L> Rotate image counterclockwise

<Ctrl+Alt+R> Rotate image clockwise

See the main menu for more shortcuts.
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Card Layout Dialog

This dialog shows up when selection File/Print postcards. Pick a layout from 2 images up to 144 images 
per page. Images are printed in highest resolution so be careful when using this function with a big 
amount of images. It might take some time.

Images are rotated to fit best in the proper image fields for best usage of space.
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Mouse Panning and Zoom
Scrolling and zooming the bitmap

Panning:

When viewing an image zoomed, meaning that the bitmap is bigger than the window and scrollbars are 
visible, then only a section of the bitmap is visible. To pan the bitmap you can use either the scrollbars or 
use Mouse Panning:

Click with the mouse somewhere in the picture and hold the left mouse button. Then move the mouse 

while the button is down. The cursor changes to  and the whole image moves with the mouse and 
allows you to show quickly invisible parts of the bitmap.

In full screen mode you also can use the cursor keys (<Left>, <Right>, <Up>, <Down>) for panning.

Hint: Mouse Panning is available only when the bitmap zoomed, indicated by visible scrollbars.

Zooming:

You can zoom the display with the mouse: First click once on the image to change the cursor to . Then
any further left mouse click zooms into the picture up to 1000%, a right mouse click zooms out down to 
25%. The current scale factor is shown in the status bar on the bottom of the window. You also can use 
the <+> and <-> keys on the numeric keypad for zooming. The ‘Multiply’ key on the numeric keypad 
resets the scale to 100%.
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File list
Ordering the files according to your needs

Specify the order of the files with the Edit menu. Files can be ordered by:

Name:

This is the default. Files are ordered by name like in the Windows Explorer.

Size:

Files are ordered by size. Smaller files at the beginning. This is useful for searching for images which are 
identical except the name. So identical images have the same size and are ordered together.

Time:

Files are ordered by time. Older files at the beginning. This is useful when downloading files from the 
internet. To check if files have properly stored just look at the newest files.

Random Order:

Files are ordered at random. Interesting for Auto Show only.

Sorting with the file list:

The file list on the left hand side of the windows can also used to sort the window. Click on the according 
columns to sort forward. Click again on the same column to sort backwards. The file list always shows all 
images found in the current directory. This directory is defined by the path from where the last bitmap 
has been opened.

Hint: Not all columns might be visible when starting JPegger. You can resize the width of the file list with
the mouse. To do so click on the right hand side of the file list, keep the button pressed and move 
the mouse horizontally.
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Directory Tree
Changes folders with a single click

A directory tree is displayed in addition to the file list.

The directory tree works intuitively. If you click on a folder this folder is used exactly like using the 
Browse function.

A complete screen shot of Vallen JPegger including directory tree can be found on Overview.

JPegger_FolderTree



Slide Show Mode
Automatically showing images

The Slide show mode allows one to show all the bitmaps sequentially in the specified order. The Slide 
show mode is started and terminated (toggle function) via Slide show out of the Edit menu or via 
shortcut <F10>.

During slide show mode a context menu via right mouse click is available. If any of the keyboard 
shortcuts are pressed the Slide show is terminates also.

The time interval each bitmap is shown is freely definable in Preferences. 
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Flip thumbnails
Select the best layout

The Flip thumbnails ( ) function flips the thumbnails from the page control on the left hand side to the
bigger right hand side. When this function is disabled (default) then the file list and the thumbnails share 
a page control on the left hand side of the window. You find this function in the menu View or as toolbar 
icon 

.

When enabled the thumbnails flip to the right side and thumbnails and image share the same page 
control. 

 

Both display modes are identical by the way they work. Find out for yourself which is most adequate for 
you. A screenshot of both display modes is also shown in the Overview chapter.
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Sound interface
Play any MP3 or Midi file while viewing images

Manual Playback with player

MP3, WAV, and MID files show up in the file lists automatically. Simply double click on an sound file icon 
to open the player.

 

The player includes basic controls to Play, Pause and Stop the current title. The long track bar is included 
for fast navigation within the sound file, the lower short one for volume control.

Important:

JPegger expects the sound files to be valid and the necessary hardware and codec to exist. There is no 
codec installed with JPegger. So if you want to play certain media formats be sure that the necessare 
Windows media Player codecs are installed. Windows 95 system might need to install Windows Media 
Player 6.4 to play MP3 files.

Auto playback when opening a folder

There was a request from a school of arts who are producing their own educational CD with images of 
ancient paintings. They already are using JPegger for their CD and wanted to add spoken comments for 
each folder on the disk.

For them we added a special sound interface which allows to automatically play back WAV, MP3 or Midi 
files when opening a folder. Now you can use this interface also for playing your own comments or listen 
to music while browsing through your images.

To use this option for your own images you simply have to add an INI file to your folder with the format 
explained below. Use any text editor like Notepad and create a file inside your image folder with the 
filename "jpegger.ini".

[SoundSetup]
FileNameMP3=intro.mp3
When Vallen JPegger opens a new folder it first checks for the file "jpegger.ini". If there is one it checks 
for the section "SoundSetup".

There you can place the entries "FileNameMP3". Behind these key entries you specify the filenames of the
sound files to play back (here a MP3 file "intro.mp3" and a midi file "passport.mid"). Be sure to give a 
path relative to the current folder of the directory when creating CDs. A good practice is to copy the 
sound files into the same directory where the images are because then you do not have to specify a file 
path.



In the example above a Midi file and a MP3 file are specified. So both files will be played back at the same
time. If you need only one sound file then remove any of the entries.

JPegger doesn’t analyze the sound file type. Therefore it doesn’t matter if the Key "FileNameMP3" 
specifies a MP3, WAV, or Midi file.

More information about this can be found at the following links:

English: http://www.agfanet.com/en/cafe/softreview/cont_softreview.php3?id=197&archive=y

Deutsch: http://www.agfanet.com/de/cafe/softreview/cont_softreview.php3?id=196&archive=y

Francais: http://www.agfanet.com/fr/cafe/softreview/cont_softreview.php3?id=198&archive=y
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Command line interface
Start up with your own options

Especially when you are placing Vallen JPegger on a CD then you might want to start it up with predefined
options. The following command line is defined:

Command line definition:
jpegger [-?] | [-help] [-ft] [-fs] [-ss:<delay>] [-sc:<scale>] [-ui] [-q] [-r] <image>

Description:

-? Pops up a short command line help, same as –help.

-help Pops up a short command line help, same as -?.

-ft Flip thumbnails on start

-fs Start up in full screen mode

-paste Paste clipboard contents on start

-mw Maximize window on start

-ss:<delay> Start up in slide show mode. You must specify the slide show interval in milliseconds as 
<delay>. If you specify -ss:5000 the slide show interval is set to 5000ms equivalent to an 
interval of 5 seconds.

-sc:<scale> Start up scale in percent. Default is zero (-sc:0) which scales the image to fit inside the 
image area. To scale the image to 100 percent on start use –sc:100.

-m3u:<file> Load Winamp compatible playlist <file> and play

-setlng:<lng>: Preselect language to avoid start-up language select dialog. Currently available languages
are (to replace <lng> with): English, Deutsch, Italiano, Portuguese, French

-p Print, used for registered file extensions in Windows Explorer with Print.

-r Recurse subfolders when folder or file name is specified

-sort:name Sort images by name on program start

-sort:random Random image order on program start

<image> image file name or image file folder

Example:
jpegger.exe -ft -ss:6000 -mw start\startimage.jpg
Calls JPegger, flips thumbnails on start, starts slide show mode with time interval of 6 seconds, maximizes
JPegger, and opens image "startimage.jpg" out of folder start. All images in folder "start" will be shown in
slide show mode in alphanumeric order.

Hint: When providing filenames or path including blanks including blanks then you can enclose one or 
each individual option by quotes to make the program understand that this is one single option:
Example: jpegger.exe -ft -ss:6000 –mw "start folder\start image.jpg"
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Uninstalling Vallen JPegger

Since Version 4.15 there is full un-installation support for Vallen JPegger.

Uninstall via:

Start / Settings / Control Panel / Add/Remove Programs.

JPegger_Uninstall



Contributions

Many people have contributed to the success of Vallen JPegger. In this section I want to thank at least 
some of them.

Software Library:

First I’d like to thank Mike Lischke for his fabulous graphics library GraphicEx which is used inside Vallen
JPegger. If you are a Delphi programmer I really can recommend to visit his site (http://www.delphi-
gems.com/) where he offers a bunch of interesting components. All of them a very well designed and 
might be of interest for you as a programmer.

I’d also like to thank Jürgen Faul for his great MP3 ID-Tag library (http://jfaul.de/), which is really easy 
to use and very helpful.

The latest contribution is coming from by Martin Djernæs from Denmark. His code for decoding the EXIF
tags in JPG files has been added lately.

Many thanks to the translators:

Nuno Justo (njusto@clix.pt), who made the Portuguese translation and a lot of testing.

Marco D’Amato (protect100@hotmail.com) who made the Italian translation. Please also visit his site 
(http://web.tiscali.it/protect/mdt.html).

Ulf Swedjemark for his Swedish translation.

Frank van de Laar for his Swedish translation.

Vincent Malien and Denis Mentha for their French translation.

Antonio Mengs for his Spanish translation.

Beta Testers:

There are really many beta testers involved in keeping the quality of Vallen JPegger. But there is one who 
really needs to be mentioned: Manfred Gotthalmseder (m.gotthalmseder@eduhi.at), a teacher at an 
Austrian school of art, who gave me most feedback. The MP3 sound interface is his idea and he uses it 
very intensively in his own educational CD of art to explain modern and anxious painting to his students. 
This CD is really interesting and I can only recommend to ask him for a copy if you are interested in art.

Installation:

The FreeExtractor from Andrew Fawcett is used for extracting the installation. Thanks to him for his 
world’s smallest stub (http://www.disoriented.com).

Disclaimer

The author is not responsible for any contents linked or referred to from his pages - unless he has full 
knowledge of illegal contents and would be able to prevent the visitors of his site from viewing those 
pages. If any damage occurs by the use of information presented there, only the author of the respective 
pages might be liable, not the one who has linked to these pages. Furthermore the author is not liable for
any postings or messages published by users of discussion boards, guest books or mailing lists provided 
on his page. 
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FAQ - Frequently asked questions

General and Installation

Q: Is Vallen JPegger running on Mac or Linux based systems?

A: No, Vallen JPegger is designed for Windows based systems only.

Q: Is Vallen JPegger compatible with Windows XP?

A: Yes, Vallen JPegger is compatible with all of the following Windows versions 98, Me, NT4, 2000 and XP.
Latest service packs are required.

Q: How to create a desktop shortcut?

A: Open File/Preferences. Click on Tab "Setup" and click "Create Desktop Icon". More Info.

Q: JPegger seems to create thousands of jpeggeri.dat files. What are these good for?

A: These files contain the thumbnail images which are created once. So if you visit an image folder a 
second time after having created the thumbnails once JPegger only loads the jpeggeri.dat file for faster 
display. The creation of these files can be disabled in File/Preferences/Thumbnails.

Getting started
Q: I have downloaded and opened Vallen JPegger, but it doesn't tell me how to browse
through my files. What shall I do?

A: Click on "File/Open" and select a file or use the Folder tree on the top left. All images in the folders are
shown automatically. Try right mouse button for context menus.

Q: I would like to show all images within a folder and its subfolders?

A: Select File / Browse (or shortcut <Ctrl+B>. Then select the folder and check "Include subfolders".

Q: When I start the screen capture suddenly Vallen JPegger disappears. What has happened?

A: When you start the screen capture then Vallen JPegger hides itself to allow you to make a screenshot 
of the desktop without interference of Vallen JPegger. Inside the Screen Capture Setup you define a 
keyboard shortcut (by default it is <Ctrl+F11>). Press this shortcut to actually take the screen shot and 
JPegger pops up again.

Slideshow Mode
Q: How do I start the slide show mode?

A: Press <F10>. Alternatively call context menu by right mouse click.

Q: How do I stop the slide show mode?

A: Press either <F10>, <RETURN>, <Enter>, <Blank>. Alternatively call context menu by right mouse 
click.

Q: How do I start the slideshow mode automatically on program start?

A: Use command-line parameter. More info. 

Q: I started Vallen JPegger command-line parameter /ss:5000 but the screen is blank on 
start?

A: Please check if the file or folder specified to show on start is existing.

Full Screen Image
Q: How do I show an image in full screen?

A: Simply press <Enter> or <Return> or use context menu with right mouse click on the image.



Q: How can I exit Full Screen mode?

A: Again simply press <Enter> or <Return> or use context menu with right mouse click on the image.

Q: How do I navigate to the next / previous image in Full Screen mode?

A: Press <Page+Down> / <Page+Up>. Alternatively press left mouse button for next image. Use right 
mouse for context menu. Press <Backspace> to go to the previous image.

Q: Where do I find a list of shortcuts used by Vallen JPegger?

A: See here. 

Q: I would like to see the images in the 1:1 scale as some of the smaller pictures look distorted
when made to fit the screen window but smaller images are always scaled to fit into the 
window. How to solve this?

A: If you do not want smaller images to be scaled to fit then use option "Shrink large images in 'Fit Scale'
only. You will find this option on tab "Startup" in "Preferences" from menu "File".

Stability Issues
Q: When I right click with the mouse on a thumbnail or in the file list a context menu is 
supposed to pop up. But instead Vallen JPegger closes or even crashes. If I right click in the 
Folder Tree or the image or in full screen mode then there is a context menu.

A: This problem has been reported on some very view machines. This is not directly a problem of JPegger
but with the Windows System itself, which is somehow corrupt.    If you right click on the thumbnails then 
the original Windows Explorer context menu is called. This context menu contains all shell extensions that
might be installed by any program on the system. When JPegger is calling this context menu some 
exception is caused by the Windows operating system which makes JPegger to close. The reason for this 
is that a previously installed program has not been uninstalled properly. Currently there is no solution for 
this problem. If you have also have this problem, please report for further investigation.

Hint: There is a workaround for this problem. In the Preferences dialog you can disable the Windows 
Explorer context menu and use an internal context menu instead.

The image selected is not supported by Vallen JPegger. We are working on 
supporting more Images
Q: Some images are not shown. The thumbnail is empty with a red cross. What does this 
mean?

A: The image selected is not supported by Vallen JPegger. We are working on supporting more and more 
formats with future versions.

Twain Import
Q: Twain import (select source) says twain.dll not exist.
A: The twain driver is part of your hardware scanning device (scanner or digital camera) and must be 
included with your hardware device. Install the hardware device specific twain driver from the device 
manufacturers software.

Printing
Q: Printing takes very long? Why?

A: Images need a huge amount of memory for pre-processing prior to sending the data to the printer. 
Depending on the available memory the printing process can take some time. All you can do is using 
smaller images or install more memory into your system if you want to increase the speed.

Q: I want to print postcards of some selected images, but JPegger only allows me to select 
only one image.



A: Simply copy only those images you want to print into an separate temporary folder and open this 
folder with Vallen JPegger. After printing you can delete the folder.

Q: I get an "Out of system resources" message during print and/or images on the page are 
blank.

A: Printing high resolution images takes a lot of system memory and you are running out of memory. 
Especially on Windows 9x machines you should be careful now as your system is getting unstable and it is
recommended to reboot. This might result that you have several print requests in your printer spooler 
and you call the print command faster than your printer is printing.

Q: How can I change the size of the printed thumbnails?

A: You can define the size of the thumbnails for printing on Tab Thumbnails in Preferences out of menu
File.

Sound Playback
Q: When trying to play a sound file I get the message  "MMSYSTEM257 Invalid MCI device ID.  
Use the ID returned when opening the MCI device."

A: There is no valid sound codec installed. Vallen JPegger doesn’t come with a built-in MP3 codec. It 
simply uses the standard Microsoft sound interface. If your sound plays with Microsofts    Media Play it 
also should play with Vallen JPegger. Vallen JPegger doesn’t use Winamp codecs. So if your sounds play 
with Winamp but not with JPegger then still the Microsoft codecs are missing or overwritten by another 
non-compatible MP3 application. Update your Media Player. If you have also have this problem, please 
report for further investigation.

However if you have this or similar errors please check this link:
http://support.microsoft.com/default.aspx?scid=/support/windows/topics/win98/media/
mmem.asp

Other
Q: I like Vallen JPegger but I haven’t sent a postcard to the author yet. What can I do?

A: Quickly send a postcard from your hometown to:

Vallen-Systeme GmbH
Schäftlarner Weg 26
82057 Icking
Germany.
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Join our Team!!

Career opportunities at Vallen-Systeme GmbH

Seeking for a job?
You like either software programming or hardware development? Or do you want to support our hardware
assembly line? Or customer or international sales support? Or technical editor for articles, presentations, 
internet and documentation?

Note: If you are looking for a full-time job in the Munich area (Germany) in the field of nondestructive 
testing please contact us today! Updated vacancies on http://www.vallen.de/job.

e-mail: job@vallen.de

Vallen-Systeme GmbH
Schäftlarner Weg 26

D-82057 Icking (Munich)

Germany

We would like to expand. We need you! Please join our team today!

JPegger_Job



CD-Starter Tool
VSTARTER.EXE

There is a tool called vstarter.exe in folder cd_start. This allows you to create CDs with a professional 
Starter program.

This program is completely configurable via the INI-file vstarter.ini which must be in the same folder as 
vstarter.exe. This program offers two buttons to the user. The left Run button starts JPegger with the 
command-line parameters defined in vstarter.ini. The right button closes Vstarter without calling JPegger. 
The image shown on this dialog must be available as vstarter.jpg. You can freely replace vstarter.jpg with 
your own image but keep the size of 300x300 pixels.

Format of vstarter.ini:
[vstarter]
JPegger_Path=..\jpegger.exe
JPegger_Params=-ft -ss:3000 -mw –s:n "images\sample1.jpg"
BtnStart=&Run JPegger
BtnClose=&Close
Rem – This is a comment line

Each line defines a specific parameter. The name of the parameter is fix (the left part) and it’s value (the 
right part) is configurable.

JPegger_Path: Defines where VStarter finds the JPegger executable file, relative to the path of 
vstarter. You must modify the given path according to your folder structure on 
your CD.

JPegger_Params: Command-line parameters to be used by Vallen JPegger. Define the proper 
command-line arguments according to your needs. Relative file references must 
be relative to the location of jpegger.exe

BtnStart: The caption of the Start button. You can localize this text.

BtnClose: The caption of the Close button. You can localize this text.

Also a sample autorun.inf file is included which shows how to call Vstarter automatically when a CD is 
inserted into your CD-ROM drive on Windows 9x based systems.



The autorun.inf ca look like this:
[autorun]
open=cd_start\vstarter.exe
shell\start=Open Image CD
shell\start\command=cd_start\vstarter.exe
The very first line is a file identifier [autorun]. The first line below the identifier specifies which program 
to run on inserting a CD with the open command. In this case it runs vstarter.exe which must be in folder
sample. The 2nd line adds an additional menu item to the explorer context menu saying "Open image 
CD" and the 3rd line defines which program to call when the user clicks this item. In this sample the 
program paths are identical between the 1st and 3rd line.

Hint: You need the first line in autorun.inf but not necessarily line 2 and 3.
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Version History
Changes between releases

V4.14:

· New: Lossless JPG Rotation with autosave. Original image is copied to recycle bin

· New: Rotate finally works with multi-select.

· New: Drag & Drop for Image Explorer

· New: Drag & Drop for MP3 Explorer (Genre and Artist only)

· New: Command-line option -sort:random added to force random image order on start

· Bugfix: MP3 Find dialog: Adding to playlist from dialog find didn't work properly under certain 
instances.

V4.13:

· New: MP3 Explorer, Dialog Find: Locate In Tree added

· New: Export of MP3 Tags to Excel added

· New: In Preferences an option has been added to disable default Windows explorer context menus. 

· Bugfix: jpeggeri.dat file was not reduced in size when images were deleted.

· Bugfix: Rare exception during updating long thumbnail lists (> 10000)

· Bugfix: Dialog "Find Duplicates" did not restore properly after cling in maximized mode

· Bugfix: Memory leak fixed when closing thumbnail lists

· Improvement: Faster update of jpeggeri.dat files

· Improved: Browse Dialog shows AVI while searching to show application is still alive

· Improved: Setup Sequence

· Improved: The result list after Find Duplicate Files has been resorted

· BugFix: File list properly handled after deleting all images

· BugFix: File list properly after adding single image to empty folder

V4.12:

· New: Installation redesigned

· New: Image sort order is saved on program exit

· New: Command-line option -sort:name added to force sort by name on start

· Bugfix: Localizations didn't work properly in MP3 Music Explorer

· All localizations updated

V4.11:

· New: Find duplicate images completely redesigned for faster file delete

· New: Music Explorer localized

· New: Button to synchronize folders between Music Explorer and Image Explorer

· New: Genre in Music Explorer Tree Genre now has Artists as sub branches

· New: Browse for folder allows one to enter path by keyboard

· New: Saving of thumbnails into jpeggeri.dat can be disabled (not fully localized yet)

· New: jpeggeri.dat files can be hidden (not fully localized yet)

· Bugfix: Files including Blank were not properly handled on delete or copy.

· Bugfix: Music Player supports XP themes

· Dutch localization updated.



· Some minor improvements of user interface when showing large number of images (>8000).

· Localizations Updated

· Default Fonts updated to use standard "Tahoma" if existing

V4.10x:

· New: Multi select added

· Thumbnails are saved into jpegger.dat in current folder

· Minor bug fixes and memory leaks on Windows 9x based systems.

V4.08:

· EXIF Tag information added. See menu Tools. EXIF information is also shown in the hint boxes of the
thumbnail view.

V4.07:

· Memory Leak on resolved when printing thumbnails or postcards in high resolution (Windows 9x 
only).

· Faster printing of images, thumbnails and cards

· Better printing performance on Windows 9x

· Super fast printing of thumbnails in low resolution

· Thumbnails are now centered on page when printing

· Footer added for thumbnails when printing

· Minor improvements

V4.06:

· Spanish language included.

· Mouse commands in slide show mode changed.

· Context menu added for image. Useful in full screen modes and slide show.

· Slide show can terminate on end.

· Timing problems in slide show resolved.

V4.05:

· History lists for folders added

· MP3 Music Explorer: Renamed from Sound Explorer

· MP3 Music Explorer: Improved search improved

· MP3 Music Explorer: Context menu item added: "Locate in"

· Minor improvements

V4.04:

· MP3 Tag Editor improved and extended

· Minor improvements

V4.03:

· MP3 Tag Editor added

· MP3 Extended Search

· Minor Bugfixes

V4.02:

· Command line switch m3u: added

· Support for XP themes added

· Minor improvements



· VStarter: always stays on top

· VStarter: Command line file references for JPegger are now relative to the location of jpegger.exe

V4.01:

· Dutch and French languages included

· FAQ section added to help

· Minor bugfixes

V4.00: New Release

· MP3 Sound Explorer added

· Full Wave file support, including player

· Twain Interface added

· Print Postcards added, Place from 2 to 144 images on one page

· Browse including subfolders (recursive browsing). Select File/Browse and check "recursive"

· Snapshot function redesigned

· No screen saver in slide show mode

· Option to fit size large images only

· Improved (faster) thumbnails when more than 1000

· Improved print function for thumbnails to print in highest possible resolution

V3.58

· Swedish translation added

· Command ine switch "setlng:" added

· Corrections in German translation

· Option to disable of Screen Saver in full screen slide show mode has been implemented

V3.57

· Minor improvements

· Print dialog saves last settings

· Scaling problem in VStarter fixed.

V3.56

· Auto delete for duplicate files included

V3.55

· Problem with some TIF-files resolved.

V3.53

· Can now be started with folder in command line

· "Browse with Vallen JPegger"    added to Explorer folder context menu after registering file 
associations.

V3.50 Minor Update

· Unnecessary FDD accesses removed.

· Tool buttons added for rotate image functions.

· Registered file extensions allow direct print with JPegger from Explorer with Print out of Explorer file 
context menu. 

· Vstarter.exe added. A tool to simplify start of JPegger on your own image CDs.

V3.49 Major Update



· Error message removed that disappeared on W98SE based systems on "Flip Thumbnails"

· Shortcuts added to rotate image

· Stability problems resolved on W98SE based systems.

· Print options added in Preferences, allows printing filename below image.

· Command line option "-paste" added

· Image resize/resample added

· Explorer and e-mail buttons added in Help menu.

· File save support added

· Image mirror

· New directory tree

· Directory tree now permanently shown without command-line option.

· Explorer context menus

· Screen shot functions added

V3.3x Major update

· Some shortcuts have changed (Page-up/Down for next image in full screen, regular cursor keys for 
panning; Full screen with enter or double click).

· Faster full screen image.

· Sound interface added.

· Directory tree added.

· Tools menu: Find duplicate files.

· File information in full screen mode.

· Image file compare added to search for duplicate images.

· Enhanced command line support added.

V3.1x Feature update

· Thumbnail print support included.

· Sort by type added.

· Minor bug fixes and improvements.

V3.0 Major update

· This version history has been added to help (ZDNet Request).

· Version numbering changed.

· Thumbnails added

· Image file filter supports individual open filters for each format (ZDNet request).

· Shortcut for "Delete File" <Ctrl+Del> has been changed to <Del> (ZDNet request).

· Exact slide show time interval can be specified in preferences (ZDNet request).

· Extended preferences dialog box.

· Desktop icon support.

· Shortcuts added for Copy and Move file commands (ZDNet request).

· Desktop wallpaper setup added.

· Problems with 1-bit BMP-files removed

· Palette problems with 256 color icons removed

· Better handling for invalid image files

· Multi threading

· Auto-update when images are deleted or moved

· Many internal modifications to improve performance, speed, stability and usability.



R2000.1201: Major update

· Full screen support with <F11> and <Ctrl+F11> (by user request).

· New keyboard shortcuts and <+> and <-> to zoom in and out (by user request).

· New Preferences dialog for start-up options (by user request).

· File format associations (by user request).

· File rename added.

· Command line support improved.

· Browse directories opens with the last open directory.

· Minor bug fixes.

· Improved help system

R2000.1101: Major update

· Toolbar added.

· Tool tips and basic hints for beginners added.

· Context menus added for file list.

· Command line support.

· Help system completely revised.

R2000.0831: Major update: 

· New image file list allows quick access to any image in current directory. 

· More image formats added and better compatibility with special formats. 

· Improved mouse panning and zooming. 

· Better support for large images.

· Better performance and higher stability 

R2000.0804: Minor Update

· Some new image formats and minor bug fixes.

· Improved image decoder.

R2000.0621: Minor Update

· Vallen JPegger doesn't create default directories under c:/vallen/ anymore.

R2000.0531: Release

· First public version. 

JPegger_Version_History



Vallen-Systeme GmbH 
The Acoustic Emission Company

Vallen-Systeme GmbH
Schäftlarner Weg 26

D-82057 Icking (Munich)

Germany

Other contact information:

General Inquiries:

e-mail: info@vallen.de 

Technical Support:

e-mail: support@vallen.de 

Sales Related Requests:

e-mail: sales@vallen.de 

Phone Number:

+49-8178-9674-400

Fax Number:

+49-8178-9674-444

Internet Address:

http://www.vallen.de

Internet Software Update Service:

http://www.vallen.de/download

Freeware:

http://www.vallen.de/freeware

Contacting_Vallen



Feedback 
About Features, Bugs, Ideas

We welcome your feedback regarding software. 

If you have ideas for new features send us your feedback. If you detect bugs, even wrong spelled words, 
please inform us.

Please include the following information with your feedback: 

· Product name and version number (important, see About or Info box of Vallen software, available 
via About button or Info from the Help menu).

· Operating system (see About or Info box of Vallen software, available via About button or Info 
from the Help menu).

· Brief description of the problem and its reproducibility

· Conditions under which the problem occurs. Best is a step-by-step instruction how to reproduce the 
problem.

· If possible include sample data files (PRI, TRA, VAC, VAE) to reproduce the problem. With VisualAE™
you can export parts of your data file.

· In some cases also a screenshot could be very helpful. Screenshots can be taken with most graphics
programs, also with Vallen JPegger (download for free from http://www.vallen.de/freeware).

Hint: When reporting Bugs please be as precise as possible. Please provide all information required to 
reproduce the problem quickly. Please provide sample data files if possible. The faster we can 
understand and reproduce your problem the faster we can help you.

For suggestions to improve help text pages or printed documents, please click here.

Please send your e-mail messages to: support@vallen.de

Thank you for your cooperation.

Feedback_Features



Feedback
About Documentation

We welcome your feedback concerning our documentation. Please let us know your comments and 
suggestions for improvements (e.g. by e-mail).

Please include the following information with your feedback: 

· Product name and version number

· Printed manual or online help

· Topic-ID (can be found in Online-Help at the end of each topic page below line)
Example: Topic-ID of this page is „Feedback_Documentation".

· Document code and page number (for printed materials, pdf-, and WinWord documents)

· Brief description of content (for example, are you reviewing step-by-step instructions that are 
inaccurate, grammatical errors in a specific paragraph, information that requires clarification or more
details, etc.).
If you are working on online documentation please copy the text to be changed in a separate 
document.

· Your suggestion for how to correct/improve documentation. Mark your changes (e.g. by bold 
formatting) if modifying online documentation.

Please send your e-mail messages to: support@vallen.de

Thank you for your cooperation.

Feedback_Documentation



Trademarks

VisualAE™, VisualClass™, VisualTR™, AMS3 and AMSY4 are trademarks of Vallen-Systeme GmbH in 
Germany, U.S.A. and other countries. 

Microsoft and Windows are registered trademarks of Microsoft Corporation.

Other brands and their products are trademarks or registered trademarks of their respective holders and 
should be noted as such.

Trademarks



Copyright

Copyright © 1986-2001 by Vallen-Systeme GmbH, Germany. All rights reserved.

Information in this document is subject to change without notice.

No part of this publication may be reproduced, stored in a retrieval system or transmitted in any form or 
any means electronic or mechanical, including photocopying and recording for any purpose other than the
purchaser’s personal use without the written permission of Vallen-Systeme GmbH. 

Copyright



Vallen Freeware
Very useful tools

Vallen Freeware are useful tools for different purposes. Vallen Freeware is available either from the 
internet or from the Vallen AE-Suite CD-ROM in the directory ‘Freeware’.

Please check the internet at http://www.vallen.de/freeware for regular updates.

You are authorized to use Vallen Freeware, and of course any kind of feedback is highly welcome.

For details regarding the different tools please see the documentation belonging to each tool respectively.

Vallen Freeware is coming as is, without any warranty regarding functionality or reliability. Vallen-
Systeme GmbH disclaims all warranties for Vallen Freeware. We shall not be liable for any direct, indirect,
consequential, or incidental damage arising out of the use or inability to use Vallen Freeware.

Vallen-Systeme GmbH reserves the right to modify, withdraw, or start selling Vallen Freeware tools 
without prior notice.

Freeware



Vallen-Systeme File Extensions

The following file extensions are specific for Vallen-Systeme software:

.vac contains all settings used for data acquisition with Acquisition32

.pri contains the AE-data acquired with Acquisition32

.tra contains the acquired TR-data with Acquisition32

.vat contains TR-data acquired with TR-Recorder

.vae contains the analysis setup for VisualAE™

.vtr contains the analysis setup for VisualTR™

.trf feature file containing results e.g. from the Feature Extractor or a VisualClass™ Classifier

.vcs VisualClass™ project file

.vcf VisualClass™ Classifier file

Hint: For analysis the analysis setup files (e.g. .vae or .vtr) have to have the same name like the data 
files (e.g. .pri, .tra, .trf), but different extensions. It is possible to copy and rename an analysis 
setup to use it with other data files.

File extensions used only by MultiPlot (the predecessor of VisualAE™):

.flt filter definition

.lsp location setup parameters

.mps defining the analysis setup for MultiPlot

Other, well known formats like .jpg, .bmp, or .txt are used as well.

general_FileExtensions



Printing: Page settings
How to Adjust Printouts

This is the standard print dialog. This dialog appears every time before printing in all Vallen programs. 
Specify all page setup settings in this dialog.

Hint: This dialog is sizeable. For a bigger display of the preview area you maximize the dialog to full 
screen with the Maximize Icon on the top right corner of the dialog. You also can zoom and pan the
Print Preview Area. See below for more information.

Orientation:

Specifies which page orientation: portrait or landscape. If Fit on Page (see below) is checked the output 
size on page is adjusted automatically.

Units:

Specifies the units (mm or 0.001 inch) for the size and position values.

Position on Page:

Defines the position on page in the specified units. You can either define the position on the page 
manually or select Center on page.

Size on Page:



Defines the size on the page in the specified units. You can either define the size manually or select Fit 
on page for automatic adjustment. Fit On Page will use all space available on the page with a standard 2 
cm border to all four corners.

Print preview area:

All changes done in the page settings are immediately shown here. If the cursor is over this area it 
changes into a magnifying glass indicating zoom functionality. Click the left mouse button to zooms the 
display up. The right mouse button zooms the display down. When the display is zoomed, keep the left 
mouse button pressed while moving the cursor to pan the display.

In addition this dialog is sizable. You can also enlarge the whole dialog to full screen for a better 
overview.

Status line:

This status line shows the current print status. It also shows in the left most panel if more than one 
preview pages have been generated.

Hint: Use <Page-Up> and <Page-Down> key to get from one preview page to another.

Bitmap:

Opens the Save Bitmap dialog to save the graphics as bitmap for later print out or import into any other 
application.

This option is available is selected Vallen applications only.

Print:

Opens a dialog to select a printer and starts printing.

Close: 

Quits this dialog.

Help:

Shows this help text.

Print



Printing: Print to Bitmap
Save Bitmap or Copy to Clipboard

The Save Bitmap dialog will save the output into a Windows BMP-file instead of sending it to the printer. 
This is useful for adding graphics to reports. 

 

Bitmap Settings

Dimensions:

The width and height of the bitmap should be specified in mm. Use pixel dimension only if you are aware 
how the printer driver will interpret your bitmap. The resulting units (pixels when dimension is in mm, or 
mm when dimension is in pixels) are shown below the edit fields. Also the estimated size (in bytes) of the
bitmap is shown.    After importing the bitmap into e.g. Windows Word or PowerPoint, set the size of the 
bitmap in the final document to the size here specified. This ensures an optimum pixel resolution 
considering the size of the bitmap, the printer resolution and the purpose of the printout. (See next 
paragraph)

Bitmap Resolution:

The bitmap resolution is defined in pixels per inch (ppi) and corresponds usually to the used printer 
resolution for both, reports and OHP transparencies. If the bitmap is for an on-line presentation with 
screen resolution, use the "Current screen resolution" as shown in the menu. If the bitmap dimension is 
given in mm, the program automatically optimizes the pixel resolution according to the size and purpose 
of the bitmap. This avoids disturbing effects, such as truncation or doubling of single pixel items in the 
final document. 

Note: A printer resolution in dots per inch (dpi) is usually equal to pixels per inch (ppi). Since some 
printer modes compose each colored pixel by several dots, the definition "ppi" is more straight for 
bitmaps.

Font Scale Factor:

A Font Scale Factor of 1,0    creates text fonts of size 10pt. (3,53mm) which is well suited for printed 
reports. (Bitmap dimension must be specified in mm). For OHP- transparencies you might prefer a bigger 



font, e.g. 14pt. This is achieved by setting the    Font Scale Factor to 1.4 (14pt divided by 10pt).    A Font 
Scale Factor lower than 1.0 is helpful with diagrams with large comment fields or many planes.

Color depth: 

The color depth defines the number of colors available for the bitmap. The larger the color depth the 
larger the bitmap size (in bytes). In most cases 16 or 256 colors are sufficient. If disk and memory space 
is not limited you can always use 64K colors 64K colors or True Color mode

Note: The bitmap size should not exceed the available main memory. If it does, then the creation of the 
bitmap might last up to minutes or even longer.

Save

Asks for a filename for the bitmap file. File type is uncompressed Windows BMP-file or standard 
compressed JPG-file.

Copy

Creates the image and copies it into clipboard for instant use in another application.

Data Compression and File formats

You can either save the bitmap either in Windows standard .BMP-format (uncompressed) or in .JPG 
format. You can change the output format with the file type combo box in the Windows Save Dialog after 
pressing the Save button.

The BMP-format is the best with respect to quality and standard but will produce huge files.

The JPG-format is produces smaller files but uses a lossy data reduction method. That means that a 
bitmap saved in JPG-format has a lower quality than before saving. This also happens when opening a 
JPG file and saving it again as JPG file. So there is a quality loss each time when saving as JPG. So, when 
using the JPG-format, you should move the compression slider to Better Quality.

Which format to use depends on your application. An optimum according to size and quality is to save a 
bitmaps as BMP-file first. If file size is a problem, use any third-party program (e.g. Paint Shop Pro, 
http://www.jasc.com) in a second step to convert the BMP-file into TIF-format (LZW-compression) which 
offers a high compression rate without losses. We cannot implement the TIF-LZW-compression directly as
it is patented and a license fee is to be paid for each unit sold. After having converted the file into another
non-lossy format you can delete the original BMP-file to save disk space.

Step-by-step printing into a bitmap:

1. Specify the dimensions of the bitmap in the Printer Page Settings. The position on page will be 
ignored.

2. Define the output resolution in this menu (the resolution should be equal to a value close to your 
printer resolution, but usually not more than 300 pixels per inch). If you already know the final size 
of the bitmap in your report and the resolution of the printer you will use to print your report, you 
can create a bitmap which can be printed in your report without any resolution loss or aliasing 
effects.

3. Specify the color mode according to the printer you will use to print your report. Black and white will
produce optimized results for monochrome (laser) printers.

Print_Bitmap



Printing Troubleshooting
Known Problems with Printing

About Windows and Printers

When we developed the DOS-based MultiPlot program we had to make a printer driver for each printer 
we wanted to support. But printers changed quickly. There are many new models every year and today 
there is no chance anymore to write a printer interface even for the most common printer models. 

So one of the reasons for Windows to become popular surely was the common printer interface. Every 
printer comes with a Windows printer driver and should work in plug-and-play mode.

But although if driver specifications for printers are clearly defined we found out that some printers or 
printer drivers are more compatible than others. That means that printer drivers even of the same 
company might support (or not) different functions and have different bugs.

We cannot give support for your specific printer. We guarantee that we are using only standard Windows 
functions when printing which are thoroughly tested on selected printers. So if you experience any 
problems when printing please first try to get the latest printer driver from your printer vendor or from 
the internet. There are more differences between drivers that one might expect.

If you could solve a specific problem with your printer

Please send us your documentation feedback about your solution that we can improve this 
troubleshooting section. Please give us and other customers the chance to profit from your results and 
send us a description of your problem, your printer type and what you did to solve the problem. Thank 
you very much for your cooperation.

The following is a list of known problems:

The printout is different from what expected

Description:

If you detect a problem with printing, e.g. the printout is different from what you expect, please first try 
to find out if there is a problem with the program or with the printer.

Solution:

Use Save Bitmap and compare the resulting bitmap with the printout. The programs basically make no 
difference if printing to a bitmap or to printer. So if you get different results you have an indication that 
there might be a problem with the printer driver.

Get latest updates for your printer driver and check the trouble shooting section in the internet of your 
printer manufacturer.

Picture overlay on diagram is not printed

Description:

There is a diagram with a picture overlay. The picture is shown on screen but when printing the diagram 
is printed without the picture overlay. When using Save Bitmap the picture overlay is drawn correctly. 
Also cases have been reported where the printer driver hangs while printing the picture. This effect has 
been reported especially with the printer drivers for HP LaserJet and DeskJet printers included with 
Windows 98/2000 installation. 

Solutions:

· A fail safe solution is to use Save Bitmap to create a bitmap and print it later.

· Get latest updates for your printer driver and check the trouble shooting section in the internet of 
your printer manufacturer.

· Try to use RAW-format instead of EMF in the printer settings (Start/Settings/Printer/Details/Spool-
Settings).



Polygons or clusters are not printed at all or printed in "white"

Description:

There is a diagram with clusters or polygons from a Polygon Processor. When displayed on screen 
everything looks fine. When printing on a monochrome printer (laser printer) the polygons and/or clusters
have disappeared. If there is a correlation diagram with many symbols then it looks like the cluster frame
overwrites the symbols in white color (paper color). This effect has been reported especially with the 
printer drivers for HP LaserJet and DeskJet printers included with Windows 98/2000 installation.

Solutions:

· Get latest updates of your printer driver from the web site of your printer manufacturer.

· Check the trouble shooting section of your printer manufacturer in the internet.

Legend texts are not centered vertically

Description:

This is a typical HP LaserJet problem. If you make a printout from e.g. VisualAE™ and look at legend 
texts inside frames (e.g. the lower description line where the file information can be found) then the text 
is not vertically centered inside the frame. All texts are a little bit too high. This effect has been reported 
especially with the printer drivers for HP LaserJet and DeskJet printers included with Windows 98/2000 
installation.

Solutions:

· Get latest updates of your printer driver from the web site of your printer manufacturer.

· Check the trouble shooting section of your printer manufacturer in the internet.

Correlations with thousands of symbols print too slowly

Description:

When printing correlations with thousands of symbols it might take minutes until the page is printed. This
is a general problem as there is a lot of data to be transferred to the printer which takes some time. 
However there are possibilities or even workarounds to reduce the problem.

Solutions:

· Use Save Bitmap and produce the printouts later.

· Use Raster graphics instead of vector graphics in the printer settings (Start/Settings/Printer). Then 
the graphics is drawn on the host machine which in most cases is significantly faster than the vector 
operations of laser printers.

· Specify a lower resolution in the printer settings.
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